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Once you've set up your iMac and followed the onscreen guide to connect to the
Internet, whats next? Read on to find out how to get the most out of your iMac:

24
30
32
34

Your iMac at a glance
Mac OS X basics

What you can do with your iMac

10
12
14
16
18
20
22

Listen to music on your computer or on the go
Create and edit your own movies
Search the Internet

Get more out of the Internet
Send and receive email
Organize, plan, and create

Keep your iMac’s software up-to-date

Learn more and solve problems

Install memory and an AirPort Card

Work more comfortably

Safety, cleaning, and power management
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Your iMac at a glance

Your computer has these built-in features:

CD-ROM or -,
CD-RW drive
Install software, use
applications, and listen to
music CDs. If you have
the CD-RW drive, you
can create your
own CDs. (For use only
with standard size,
circular discs.)

B b B e ecoaaocc e o oo oo oonocscesosancarssanssnsonnne Microphone

() Power button
* Turn your computer on
or put it to sleep.

i) Headphones port -, <)) Volume controls

; 2 Media Eject key
Two internal ... I Eject a CD.

stereo speakers

i AAAAAN 0L

Apple Pro Mouse
An optical mouse you
can use on almost
any surface.

USB port -.,

Connect a USB device,
such as a joystick or

graphics tablet.
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¢ Modem -

Connect to the Internet,
browse the World Wide
Web, and send email.

2,

Transfer video from

a DV camera. Connect
external hard disk drives,
printers, and scanners.

k'! Sound input *-.

Record sounds using
an analog microphone
or other audio device.

i Sound output
Connect headphones,
external speakers, and
analog audio devices.

O Reset button

o’ o .
= FireWire -

+ Tuss

Connect printers, Zip
and other disk drives,
digital cameras,
joysticks, and more.

« &9 Ethernet

Share files with another
computer and access
a computer network,
printer, or the Internet.

.- VGA output

Connect an external
monitor or television for
video mirroring.

Access door

Install additional memory
and an AirPort Card for
wireless networking.

Use during To learn more about your iMac’s features:
troubleshooting to restart = Choose Mac Help from the Help menu, then click
your computer. Go under “Discover my iMac.”
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Mac OS X basics

The Macintosh desktop is your starting place.

Apple menu - 8% Finder File Edit View Go Window Help & ) 11:23 AM
Use to change About This Mac T ———— . 1 Modem status
G MAC OF Xl Use this menu to connect

system settings, open E
recent items, and restart E’::;"‘ A e < to and disconnect from
or shut down your e Macintosh HD the Internet using

computer. To see the a dialup modem.

menu, click the apple

Recent Items

(&) in the menu bar. olee O
Sleep
Restart
Shut Down
tegOut..  oxo [ R Toolbar button
Click to show or hide
Window buttons -1 f & tclark3 the toolbar.
Click the red button to w . ¢ @ A
close the window, the cn:r;]fm Home Favorites Ap;ﬁuns

yellow one to minimize it
into the Dock, and the
green one to resize it.

Documents

D et i 0909090909000 Ry Toolbar icons

[Lﬁ Click to navigate quickly
Music Fictures to different folders.
Your home folder

View buttons =l SEE———— - contains your personal

Click to see your documents.
files as icons, in lists,
or in columns.
""" Trash

Drag an item here to
delete it. ltems remain

Finder icon To learn more about Mac OS X: here until you choose
Click to open a = See the Welcome to Mac OS X document in the Empty Trash from the
Finder window so Documents folder on your hard disk. Finder menu.

you can see the files
and applications on
your computer.
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Application menu
Shows the name of the
application you’re using.
Use to set preferences
or quit applications (other
than the Finder).

Application

Applications are software
programs (such as a
game or word processor)
that you use with your
computer. Double-click
an application’s icon to
open the application.

Document

Documents are files that
you create with an
application (such as a
letter you create with your
word processor). Double-
click the icon to open the
file in the application used
to create it.

A8 File Edit ) 11:23 AM

View Go Window Help

* About the Finder

Preferences. .. E[
Empty Trash o—
Macintosh HD
Services
Hide Finder ﬁ ... Disc
Hide Others “ -
Show All Audio CD This appears when a CD

is in the disc drive.
Double-click the icon to
see what’s on the disc.
To eject a disc, press and
hold the Media Eject (&)
key on the keyboard.

| A Applications
. 4 @ A

>

i Computer Home Favorites Applications

Calculator Clock

ﬁ | ' Documents
iMovie |‘!_=| m' L4 735
: Computer Home Favorites Applications
| >~ Folder
Book report Bassoon Insects Folders help organize
= your files and

=)
Poetry

applications. Double-
click a folder to
see what’s inside.

Berceuse.mp3

Dock
Click icons in the Dock
to open applications,
documents, folders,
or minimized windows.
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Change the Mac OS to suit your preferences.

There are lots of ways to customize Mac OS X.

To change Finder =

settings, choose
Preferences from the
Finder menu.

Choose System
Preferences from
the Apple menu to
change most of your
computer’s settings.

To select a desktop ==+{-==

background picture, open
System Preferences and
click Desktop.

& Finder File

Edit

View Go

Window Help

5

Finder Preferences

Show these items on the Desktop:
Z!\ard disks
?Removable media (such as CDs)
W Connected servers

New Finder Window shows:

System Preferences

=

o 1]
i,
Show All - Displays Sound Network Startup Disk
Personal
- P
L ... B e °
Desktop Dock General  International Login Screen Saver  Universal
Access
Hardware
Q |E oL o] A telark3 (=)
H B =7 i [
ColarSync Displays  Energy Sa @ E: = * 7

Internet & Network

@

Internet

System

]

Classic
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Back

View

@ a

Network  QuickTimi

gn
& ®
Date & Time  Software|
Update

i Computer Home Favorites Applications

; e
= f { i i
|
ﬁ. =z ——
= =
=

* To change icon sizes
or the background of a
Finder window, choose
Show View Options from
the View menu.

& ) 11:23 AM

E

I
H

"cn
a

To change the size of
the Dock or move it to
a different place, open
System Preferences
and click Dock.



Click the icons in the Dock or toolbar to find and open files and applications.

Finder File Edit View Go Window Help ) 11:23 AM

files, and folders
into the Dock for
one-click access.

|+ Applications

P v A G b

Computer Home Favorites Applications  Movies  Music *
| Applications »  [7} Acrobat Reader 5.0
| Library .. Address Book

| System | AppleScript S
|4 Users [ AppleWorks 6 [
|71 Caleulator

& Chess

() Clock

Image Capture |
£ iMovie

¥/ Internet Connect
£ Internet Explorer

MICTTESHD

-+ To set up the toolbar the
way you want it, choose
Customize Toolbar from

the Finder’s View menu,

then drag items to

the toolbar.

yvy

** Press a folder icon to
see its contents and open
items in it.

4 Bassoon
| Berceuse.mp3
2 Book report

| Insects >
4 Poetry

Show In Finder

This side of the Dock -
shows application icons.

H H This side of the Dock
* The triangle indicates the shows files, windows,
application is open. * Drag this bar up or down to and folders.

resize the Dock.
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What you can do with your iMac

Not sure how to get the most out of your new iMac? Read on for a few ideas.

Make your own CDs. Use ilunes é to transfer music from your CD collection. If your iMac has
a CD-RW drive, burn your own music CDs. Transfer music to an iPod or other MP3 player to listen
on the go. Make a movie. Shoot video on a DV camcorder and import it into iMovie ﬁ Then

rearrange, edit, polish, and add titles and soundtracks. Connect to the Internet to send email and

browse the Web, or use i1ools @ to post digital photos on the Web for everyone to see.

Browse through the next few pages to find out more.
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The iMac is your
digital hub.

Send digital photos to 08 .

friends and family. *e W _
O ' o Import and edit

° home movies.

s ‘ wiEm v

Bk view 1Disk Computer Home Favorites Applications
v

4 Address Book e
1 Applescript 173 iMovie Read Me (Web).
T ¢ 17 Resources .
Audio €O

Name: iMovie
Kind: Applcaion
Size. 7.9
Created: 3131/01
ecescescssscsee Modifed: 3721701
eseccescseccece

Image Capture

Put up to 1,000 songs in R o Folders: (Pictires: oves snd Wik fldery 199 Send email and surf
your DOCket. Automatic Task o% the 'Net.

Hot Plug Action: | Image Capture Application

Applcaton 10 open when & camara s connected.

Connect to the Internet
wirelessly.

Listen to music and burn
your own CDs.
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Listen to music on your computer or on the go.

Use iTunes to create a library of music and make your own CDs.

Library

Your collection of
songs, imported from
your own audio CDs or
downloaded from the
Internet. Easily browse
or search for music.

Radio Tuner

Choose from hundreds
of Internet radio
stations - jazz, rock,
talk, and more.

Audio CDs

Play an audio CD on your
computer. Import songs
to your Library

to play them without

the CD.

10

) 11:23 AM

E‘
Macintosh HD

Audio CD

@ iTunmes File Edit Controls Visuals Advanced Window Help

iTunes

|| & Classical
{ Dance
4 Exercise
4 Mediration

tachlan [

Used: 217.8 MB Equalizer

To learn more about iTunes:
= See iTunes Help, available in the Help menu.
= Go to www.apple.com/itunes
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Portable music

If you have an Apple
iPod, transfer up to
1,000 songs for
listening on the go. Go
to www.apple.com/ipod
for more information.

Playlists

Make personalized
playlists using songs
from your Library.
Arrange your music by
mood, artist, genre, or
however you like.

Equalizer

Adjust the sound to
your tastes using
the 10-band EQ with
22 presets.



@ iTunes File Edit Controls Visuals Advanced Window Help < 4 11:23 AM
If your computer has a CD-RW = il
drive, you can create your own . i o

= T — Audio €D

music CDs. s T .

12 My Playlist  Outta My Head lggy Pop
P PIACh ME 400 o arenaned Ladies
Yz Porcelain OL  Maby,
™ Supernova Liz Phair
Wi = & iTunes

=
° ° e Please insert a blank CD... €'

(== Search

[FaTSong " Time  Artist

12 Library . Porcelain 401 Moby L

' Radllo Tuner # Supernova 2:49  Liz Phair f

B My Playlist o Sweet Surrender 3:57 Sarah Maclach)
& American Woman 506 The Guess Wh
# Walkin' on the Sun 327 Smashmouth |

 Disillusion 5:19 Badly Drawn B
# Ghost World 330 Aimee Mann “Y

L 14 songs, 1:11:57 total time, 75.8 MB

» You can fit up to 74 minutes of songs on a
standard music CD.

P To find out which recordable CDs
work best with your computer, go to
www.apple.com/itunes

Click the icon in the Dock to Click Burn CD and insert a CD-R disc.
1. open iTunes. . Then click Burn CD again to start.

Drag songs from the Library to a
2. playlist. Then click the playlist.

11
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Create and edit your own movies.

Use iMovie to edit video from a digital video camera.

Shoot video with a digital video
1. camera. Then connect the DV camera
using a FireWire cable.

In iMovie, bring in your video
2. clips, then edit and polish them
into movies.

Export your finished movie
3. back to tape in your DV camera
or to a QuickTime file.

To learn more about iMovie:

= See iMovie Help, available in the Help menu.

= Go to www.apple.com/store to find compatible
DV cameras or to purchase a 6-pin to 4-pin
FireWire cable.

12
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With iMovie, you can add music, voiceovers, titles transitions, and more.

iMovie File Edit Advanced Help

¢ ) 11:23 AM

iMovie monitor -1l
Preview your movie or
view video from a
connected DV camera.

Mode switch -
Switch between ‘
importing from a DV
camera and editing.

N
0201

Clip 03

06:07

-,

Clip 04

~ Clip 06

Clip 05

M

;fﬁlms ‘ Transitions ‘ Titles | Effecl;—l Audio )

Clip Selection: Clip 06 Time: 03:04

Viewers *

Frge Space: 32.66GB [ ﬁ OMB

——

Click the clip viewer
(eye tab) to edit and
place clips. Click the
timeline viewer (clock tab)

to edit sound.

|

Playback controls *
Use these to play the movie in the
iMovie monitor. Click the Play Full
Screen button to use the
entire screen.
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- Shelf

Clips appear here when
you import them. Move
clips to the viewer

to make them part of
your movie.

Editing buttons

Click to open panels for
adjusting and selecting
sounds, video effects,
titles, and transitions.
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é Explorer File Edit View Go Favorites Tools Window Help & ) 11:23 AM

Search the - ———

Back Forward Stop Refresh  Home - AutoFill Print

Internet. ~ O

If you know the Internet
address, you can go @

Create DVDs. - . % Make Movies.

there directly. ‘ W \ _‘
8 V) =

h HD

The center of your

dlgltal lifestyle. ﬁ

Print easy.

n%l;

P> If you have a dialup connection, you can use the
modem status (%) to connect to and disconnect
from the Internet.

Take Pictures. Watch DVDs.

e e

Surf the Internet.

& Internst zone

To learn more about Internet Explorer:
= Open Internet Explorer and choose
Internet Explorer Help from the Help menu.

Click the icon in the Dock to open Type the Internet address and press
1. Internet Explorer. 2 . Return on your keyboard.

14
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& Sherlock File Edit (ind Channels Help ¢ ) 11:23 AM

Sherlock |
ey — F

Macintosh HD

Or you can search the Internet
with Sherlock.

Sherlock

&P Ask Jeeves

£ a@aedemeR

r—

[ Excite |
[@ Headhunter.net @ |why is the sky blue? J @

Name TRelevance T
‘ Why s the sky blue? (N www.why-is...sky-blue.org

IDROORRS

‘ Why Is the sky Blue? NGRRARRORROR math.ucr.edu
‘ Blue Sky - Why is the Sky Blue? (R www.scienc.. desimple.com
n ART-Why is the Sky Blue? [ floodplain.org
n Why Is the sky blu... is the sunset red? M0 weather.about.com
Why is the sky blue? (T www.compendium.org
Why is the sky blue - guiz list R www.why-is...sky-blue.org

Items Found: 90

P> Click the other buttons to find people, read the
: news, shop, and more.

P> Click the hard disk icon to search the files on
your computer.

Click the icon in the Dock to Click the Search button (Q). Then
1. open Sherlock. . double-click an item in
the list of sites.

Click the Internet icon and type
2 . aquestion in the search field.

15
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Get more out of the Internet with iTools.

iTools is a suite of Internet services integrated into Mac OS X.

iDisk
Your own storage space on Apple’s Internet

Edit View Window Help ¢ A 11:23 AM

@ System Prefs

server. Share photos, movies, and other g\
files over the Internet. Access your files from :
another Macintosh or PC. 00 - Internet izl dlal>
« =& 4
5 — Homepage Show All Displays Sound Network Startup Disk
@r° iz
@/@ Build a personal Web site in three easy fitools | Email | web | News |
\ )ﬂ@/\ steps. Create a photo album, publish |

an iMovie, post your résumé, and more.
Anyone can view your site on the World
Wide Web.

Set up your iTools account

Enter your member name and password. This
information is used to access iTools, including
your iDisk and your email account.

iTools Member Name: |tclark3

iCards Password: sesesses)
Send an elegant iCard, just right for any
occasion. Choose a ready-made photo, or
create a personalized iCard using a photo { S pand bt ot iy
on your iDisk. {

Need an account?

Get the most out of the Internet with iTools. Click

{ signup

~ Email

-~ Get your own Mac.com email address.
It’s easy and works with your favorite
email application.

To learn more about iTools:
= Go to www.apple.com/itools and click Help on the
iTools menu bar.

P> If you signed up for iTools when you first turned P> To sign up for a new iTools account, open
: on your computer, you already have an account. System Preferences and click Internet. Then
Go to www.apple.com/itools to get started. click Sign Up.

16
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Store pictures, movies, documents, and other files remotely.

@ Finder File FEdit View MM Window Help
Computer
Home
iDisk
Favorites
Applications

Recent Folders
Go to Folder...
Back

Connect to Server...

P> To access your files from another
: computer, log into your iTools account at
E’ © www.apple.com/itools

& ) 11:23 AM

Macintosh HD i > Anyone can access the files in your Public folder.

i P> To find out how to use pictures and other

: files from your iDisk to create a personal Web
site, go to www.apple.com/itools and click the
HomePage icon.

M telark3

- e A

i Computer Home Faverites Applications

About your iDisk

Maovies

Choose iDisk from
1. the Go menu.

Documents
=

3

Pictures Public

= |00 Copy

¥ Copying "movie trailer.mov" to "Movies"

Software

Item: "movie trailer.mov"
Copied: 4.4 MB of 9.3 MB
Time remaining: About 5 secands

Drag files to a folder on your iDisk
2 . tocopy them.

17
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& o) 11:23 AM

é Mail File Edit View Mailbox Message Format Window Help
No mailbox selected E“
. . e R 3 / w o (q E Subject w @ Personal Mailboxes Macintosh HD
Selcte Reply Reply All Forward Compose Mailbox —Cet Mail Search Mailbox Bouthox
. | Drafts
0 messages 7 Sent Messages

. # From Subject Date@ fime & | v & Tools:tclark3@mail.ma
[2INBOX (Offline)

Follow these steps to create
and send a message.

P> To check for new messages, click Get Mail.
To view a message, click its subject.

P> If you entered email information or got a

: Mac.com account when you first turned on your
computer, Mail is already set up. To set up a
new email account, choose Preferences from
the Mail menu, then click Accounts.

Click the Mail icon in the Dock
].. to open the Mail application.

18
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2.

& Mail

File

Edit

View Mailbox Message

Format

Window Hel

INBOX on iTools:tclark3@mail.mac.com

P

& o) 11:23 AM

/=S =& &9

Forward  Compose  Mai

Cer Mail

1
Subject ¥ @ Personal Mailboxes E

Search Mailbax Eioutbox

0 messages — Connecting ta mail.mac.cam...

# From

= Macintosh HD
1 Drafts

Subject

F7Sent Messages

®eoce New Message

Date & Time ¥ #® iTools:telark3@mail.ma

[EINBOX (Offline)

v & @ A Q9 N

Send Artach Address Fonts Colors Save As Draft

(=]

To: jandoe@mac.com|

Ca

Subject: | Reunion

Dear Aunt Jan,

We'll see you Saturday morning, with bells on.

Love,
Tani

To create a new email message,

click Compose.

Download from Www.Somanuals.com. All Manuals Search And Download.

I'm really looking forward to seeing you and Uncle Johnny this weekend. It's
been too long. You won't believe how our little Andrew has grown!

Type the email address and a

subject. Then type your message
and click Send.

To learn more about Mail:

= Open Mail, then choose Mail Help from the
Help menu.

= Go to www.apple.com/macosx/applications/

mail.html

19



Organize, plan, and create using AppleWorks.

Use AppleWorks for writing, drawing, making presentations, and more.

Layout capabilities
Add photos, tables,
charts, and sidebars.
Link text frames, layer
graphics, and wrap text.

Word processing
Write letters, create
brochures, make
greeting cards and
party invitations.

Presentation tool
Create an onscreen
slide presentation.
Add movies, art,
graphs, and charts.

Database

Keep records, save
addresses, make
inventories. Merge
mailing information with
the word processor to
send form letters.

20

Quarterly N

Make Cooking Fun,
Fresh, and Fast

Duis autem vel eum iriure dolor in hererit
in vulputate velit esse molestie cor juat
vel illum dolore eu feugiat nulla facili
accumsan et iusto odio dignissim.

Making a Perfect Brew
Ut wisi enim ad minim veniam, quis
nostrud exerci tation ullamcorper
suscipit loborts nis! ut aliquip ex ea
commodo consequat. Duis autem
vel eum iriure dolor in hendrerit in
iputate veit esse.

Cooking
Dinner for Six

Ut wisi enim minim
veniam, quis nostrud
exerci tationegm

per suscipit obortis
Ut wisi enim ad minim veniam, nostrud
‘exerci tation ullamcorper suscipit lob
facilisis at vero et accumsan.

Gourmet News

ver

Winter 2000

0

Gourmet News Presentation (DR)

Cooking tips
 Chop the onions
* Slice the tomtatoes
* Mix with peppers

* Add 1 cup of olive oil

* Suaté for 30 seconds

* Serve hot

Gourmet News

324 Sunview Way
San Ramon

(6] Controls

Intro

oe

Nutitional Tips
Food pyramid Groups Examples | Nutients Diet | Wb ink
@< Fats Candy None 0.1% | wwwiats.com
R Dairy Chesse Calcium 16% | www.daimeat.com
“ &meat afish &protein
* Fruit Apple Vitaming 33% | wwwiritvegies.com
sveges | &camot &minerals
Al Grains Bread Fiber 41% | wewfibergrains.com

Clippings

Search: | Food
¥ Search web Content

|  Search

e B

e
romantic dinner

<]

appetizer

1

bowl of salad cup of tea
¥ Details
A search £ Animals / Fo... | Household [ »
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Customizable
templates

Choose from a wide
range of predesigned
documents and modify
them as needed.

Spreadsheet
Compute data easily
using over 100 built-in
functions, then use
formatting options to
make it stand out.

Painting

Create art from scratch
or apply effects to
existing pictures

or scanned photos.

Extensive

clip art libraries
Choose from over
25,000 high-quality
clip art images.



To get started using AppleWorks:

@ AppleWorks File (i1 Window © Help

Starting Points.

A0'g @ 4 <

Word Processing  Spreadsheet Database Drawing Painting

=

Presentation

Starting Points

D)

11:23 AM

E |

Macintosh HD

7

%1

7

gp

#1 Dad Certificate Agenda

All About Presen.. Art Presentation  Award Certificate

Banner

1 Click the icon in the Dock 2

to open AppleWorks.

Click the type of document you want
to create, or click the Templates tab to

modify a ready-made document.

P> Click the Web tab to download more templates
from the Internet.

To learn more about AppleWorks:

= See AppleWorks Help, available in the Help menu.

= Go to the AppleWorks Web site at
www.apple.com/appleworks

21
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Keep your iMac’s
software up-to-date.

Use Software Update to
get the latest updates
and drivers.

P To use Software Update, you must have an
Internet connection.

22

L.

@ Finder File Edit

View Go Window Help

806cC System Preferences

& o) 11:23 AM

« = H

=

Show All Displays Sound Network Startup Disk

Personal

m .

Desktop Dack General

Hardware

ColarSync Displays  Eneray Saver

Internet & Network

& @ a

Internet Network QuickTime

System
A o
(] H @)
Classic Date & | Software
Update

Click the icon in the Dock
to open System Preferences.

b 0 &8 @

International Screen Saver Universal
Access

4

Keyboard Sound

Sharing

¢ @ 4

Speech Startup Disk Users

Click
2 . Software Update.
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é Software Update Update Edit Window Help

P> Click the name of a software item to learn
more about it.

& ) 11:23 AM

Software Update

2

i | - = _ P> You can schedule your computer to check
e L_J ’& @ @ automatically for software updates.

Show All  Displays Sound Metwork Startup Disk

Software Update checks for new and updated versions of your software based on
information about your computer and current software. 8 0 e Softwarepdate

Update Software: &) Manually
® Automatically @ Software Update found the following new or updated

O, = software for your computer.

Checking oceurs only when yau have a netwark connection.

Click the checkbox to select the software you want to install:
install "Name- Version  Size

2.5MB

M Mac 0s X Update 1011 14.4M8

'.Shawl_aq e E Update Now =

Status: Software Update was last run at 1:20 PM on 11/2/0L. D AirPort Software 2.0

The 10.1.1 update delivers improvements for many USB and
FireWire devices, including support for additional digital cameras,
and overall improvements to CD and DVD burning. Enhancements
have been made to AFP, SMB, and WebDAV networking, as well as
improved support for printing. This update also delivers better
application compatibility, including updates to the Finder and Mail
application. In addition, hardware accelerated videa mirroring has
been enabled for the new PowerBook G4.

Status: Net installed, restart required.

Updates to install: 1 o ( Install )

]

Then click 4 Select the software you want to
3. Update Now. . update and then click Install.

23
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Learn more
about using your

computer.

Look in Mac Help for
more information on using
your computer.

P To browse the features of your computer, click
i Gounder “At a glance.”

p Click Quick Clicks topics for answers to
frequently asked questions.

P To look at Help for other applications, click
the ? button.

24

3‘ Help Viewer

Edit Help e

eoe Mac Help

File

Vi'\ow do | play an audio CD? e @
\

Quick Clicks What's new?

What do | use the New features in Mac OS
Finder for? Xv10.1 More

How do | change my
Computer settings?
computer settings’ Your Computer

What do | do to get ata Clance Go

connected?

Can | send email? News

How do | print my_ Info about
documents? compatibility and
D updates More

& o) 11:23 AM

=
Macintash HD

8086 Mac Help

how do | play an audio CD?

|

Answers

Page 1 of 2 abaut "how do | play an audio €D" in Mac Help

Playing an audio €0 seses

Using iTunes for Mac @5 X ~ sesss

Connecting headphones to your
computer

Connecting speakers to your
computer

Changing the sound

Using Quicktime ta play movies
and music on your computer

)

Click the Finder icon
in the Dock.

Then choose Mac Help from
the Help menu.

Types of recordable €0 media

About CD-R discs

About CO-RW discs

5 Type a question

and click Ask.

4 Click an item in the list

of Help topics.
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These Apple Web sites will help you get the most out of your computer.

HotNews  Hardware Software FMadedMae" Education  Creatve  Smallsiz  Developer  Where to Buy

“Create Your Account—— View Current Order — Education —Federal— Worldwide —Helpy

Macintosh Products Guide [ Mac

Hardware
Software
Special Offers.
New This Week
Search

Hot Deals

Tips and Tricks
oy Macroms Magazina

Mac 05 X Products

Iy

X

]

a

i
canon
S800 C

Canon

0 Coldt
N1220U USB Scanner Bubbio.ot Photo Printor

Submits Prodict PG Marketing Programs | HPGMWeb Badtes | Feedback

00 © Macintosh Products Guide =) 800 G The Apple Store (US) S 800 ® AnpleCare Service & Sapport [USA] =)
9 e @ = = o e fr e S = o @ @ fr e S = o
Back _orvard _Stop _ Refresh _Home __Autoril__Print__ Mai o sack_orward Refresh _Home __AutoFil_Print_Wai o Back _forwurd Stop _Refresh _Home __Autorill__print__ Mai —
@ [ (© v .apple.com/store. om /support
| “sore | iools | icards | quickrime | support | Macosx | [ @& Store Tools icards | QuickTime | Support | Mac 05X

Store iTools icards QuickTime upport Mac 05 X
‘Protection Plan Downioads  Specifications  Knowledge Base  Discussions  Support Index

- . h (= Apple Store
*  ThenewiPod. ] %“ | e ‘
1000 songs i you packet, (
=8 LY O
= =
B —r-)
All :

3=
iMac Power Mac G4

ﬁ dezzli {panel i
() ‘ "Top MacOS X Apps
e
D102 Uoaroe
- Offie o oirode
 Qusenzo0z

+ Print Explosion

PowerBook G4

) | AppleCare
h Get online help!
' ign up for an

Apple D today.

- Shipping Delays

- What's New

- Knowleage Base

(Expert
iscussions

nowledge

chive

- Downloads

AppleCare

Service and Support

Multi-Lingual Support | &) © Support Site Index

Macintosh Products Guide
www.apple.com/guide

K

Mac

For great hardware and software products
for your Mac, check the Web site or look for
the Mac symbol. Also get contact and
support information for third-party software
manufacturers.

Apple Store
www.apple.com/store

Purchase the latest Apple and third-party hardware,
software, and accessories.

Apple Service and Support
www.apple.com/support

Product support, software updates, and
technical information.

P From these Web sites you can quickly link to
other Apple Web sites around the world.
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Advice and troubleshooting

If you don't find the answer to your problem

on the following pages:

Look in Mac Help.

= In Mac Help (see page 24), you can find a great deal of troubleshooting
advice, including information to help you solve problems with

= Connecting to the Internet

»  Using software installation and restore discs
= Changing your computer’s settings

= Printing

= And more

m Click the Finder icon in the Dock, then choose Mac Help from the
Help menu. Type a question in the search window (for example,
type “How do I eject a disc?”) and click Ask.

Switching between Mac OS X and Mac OS 9

Your iMac is set to use Mac OS X. Most applications made for Mac OS 9 will
work in the Mac OS X Classic environment. Just open the application as
you normally would. You can also start up your computer using Mac OS 9.
To set your computer to use Mac OS 9:

= Choose System Preferences from the Apple (#) menu in Mac OS X.

m Click the Startup Disk icon to open the Startup Disk pane.
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= Select the Mac OS 9 folder as your startup disk. If the icons are
dimmed, click the padlock icon and enter the password you chose
when you first set up Mac OS X.

m Click Restart.

To set your computer to use Mac OS X again:
= Choose Control Panels from the Apple (@) menu.
= Open the Startup Disk control panel.

= Click the triangle next to the hard disk that contains your operating
system folders.

= Select the Mac OS X System as your startup disk.
m Click Restart.

If the computer won't respond:

First, make sure the mouse and keyboard are connected.

= Unplug and then plug in the connectors and make sure they
are secure.

Then try to cancel what the computer is doing.

» Try to force problem applications to quit. Hold down the Option and
Command (&) keys, then press the Esc key. Select the application and
click Force Quit.
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If the computer still doesn’t respond, restart it.

= Hold the Power () button on the computer for five seconds. When
the computer turns off, press the Power button again to restart it.

» If that doesn’t work, press the Reset (@) button.

= If that doesn’t work, unplug the power cord from the computer.
Then plug the power cord back in and press the Power button on
the computer to turn it on.

Then do this:

If the problem occurs frequently when you use a
particular application:

» Check with the application’s manufacturer to see if it is compatible
with your computer.

= For support and contact information about the software that came
with your computer, go to www.apple.com/guide

If the problem occurs frequently:

= You may need to reinstall your system software. Choose Mac Help

from the Help menu and type “install system software” for more
information.

If you see a flashing question mark
during startup:

If the computer doesn’t start up after a delay, hold down the
Option key and restart your computer.

= When your computer starts up, click the hard disk icon, then click
the arrow.

Then do this:

After the computer starts up:

= Open System Preferences and click Startup Disk. Select a local
Mac OS X System folder.

If the problem occurs frequently:

= You may need to reinstall your system software. Choose Mac Help
from the Help menu and type “install system software” for more
information.

If the computer won't turn on or start up:

First, make sure the power cord is connected.

m Make sure both ends of the power cord are plugged in securely.
Make sure the power cord is plugged into a powered electrical outlet.

= If your computer is plugged into a power strip, make sure the power
strip is turned on.
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If that doesn’t work, or if you hear strange sounds during
startup:

= Ifyou recently installed additional memory, make sure that it is
correctly installed and that it is compatible with your computer.

m If that doesn't work, press the Reset (@) button, wait a few seconds,
and then press the Power (D) button.

= See the service and support information that came with your iMac for
information on having your computer serviced.

If you can't log into your computer:

Make sure you are typing your user name and

password correctly.

= Make sure you are using the same capitalization and punctuation that
you used originally. Check to see if the Caps Lock key has been
pressed.

If that doesn’t work, reset your password.

= Insert the Mac OS X software install CD that came with your computer.
Restart your computer while holding down the C key. When the
Installer appears, choose Reset Password from the Installer menu and
follow the onscreen instructions.
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If your printer won't respond or work correctly:

Check all cables and connections.

= Make sure the printer is plugged into the computer and an electrical
outlet. Make sure the printer is turned on.

Make sure your computer is set up to use your printer.

= Install the software that came with your printer. See the documentation
that came with the printer for instructions.

= Open the Print Center application in the Utilities folder. Then select
your printer.

Ifyou can't eject a CD:
Make sure the disc is not in use.
= Quit all applications that are using files on the disc.

= Then press the Media Eject (a) key at the top-right corner of the
keyboard.

m If that doesn’t work, drag the disc’s icon to the Trash.

= Ifthat doesn’t work, restart the computer, then hold down the mouse
button. To restart, choose Restart from the Apple (@) menu.
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If you have a problem with a third-party
software program:

Make sure the software is compatible with your version of
system software.

= See the documentation that came with the software. You can check the
version of system software you have by choosing About This Mac from
the Apple (@) menu.

To resolve other problems with software, contact the
software manufacturer.

= For support and contact information about the software that came with
your computer, go to www.apple.com/guide

If you have a problem with your
Internet connection:

First, make sure the telephone line or Ethernet cable is
properly connected to your computer.
= Wait a while, then try connecting again.

If that doesn’t work, make sure your Internet settings are
configured correctly.

= Open the Internet Connect application in the Applications folder to
check your dialup or AirPort settings. Open System Preferences and
click Network to check your Internet settings.

= Ifyou're not sure of the correct information for your Internet settings,
contact your Internet service provider.

If the Apple Pro Mouse isn't

responding properly:

First, make sure the mouse and keyboard are connected.

= Unplug and then plug in the connectors and make sure they
are secure.

If that doesn’t work, try using the mouse on another surface,
like a mouse pad or a notebook.

= Non-reflective, opaque surfaces without repetitive patterns
work best.

If you run out of room and want to keep the mouse clicked
while you lift it:

= Click the mouse, then squeeze the sides with your thumb and fingers
and lift the mouse.

If the mouse clicks too easily or not easily enough:

= Turn the ring on the bottom of the mouse to adjust the tension
of the click.

For the latest troubleshooting information, go to the
Apple Support Web site at www.apple.com/support
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Install memory and an AirPort Card.

For detailed instructions, refer to Mac Help (see page 24).

Open the access door using a coin to Touch the metal shield inside the To install memory, insert a memory
1. turn the latch. 2 . recessed latch area. Then unplug the . module into one of the two lower
power cord. slots.

P> Touch this metal before you touch any parts
: inside the computer. Don’t walk around the

room until you've finished installing memory or i ) Be sure to align the notches on the module with
: the small notches inside the slot.

Before installing:

= shut down the computer

= unplug all cables, except the power cord :
= place the computer face down on a soft cloth an AirPort Card.

30
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4 To install an AirPort Card, detach the Connect the antenna firmly to the 6 Close the access door and use a coin
. antenna from the guide rail, then . AirPort Card and insert the card . to close the latch.
remove the protective plastic cap. sideways into the slot.

P> For instructions on using the AirPort software,
: look in the Help Center, available in the Help
menu.

¢ Never turn your computer on unless all of its
internal and external parts are in place.
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Work more comfortably.

The guidelines in this section can help you work more comfortably with

your computer. For detailed information about ergonomics, Mouse

see Apple’s Environmental Health and Safety Web site at = Position the mouse at the same height as your keyboard. Allow

www.apple.com/about/ergonomics adequate space to use the mouse comfortably.

Keyboard Chair

= When you use the computer keyboard, your shoulders should be = An adjustable chair that provides firm, comfortable support is best.
relaxed. Your upper arm and forearm should form an approximate Adjust the height of the chair so your thighs are horizontal and your
right angle, with your wrist and hand in roughly a straight line. feet flat on the floor.

= You may have to raise your chair so your forearms and hands are at the = The back of the chair should support your lower back (lumbar region).
proper angle to the keyboard. If this makes it impossible to rest your Follow the manufacturer’s instructions for adjusting the backrest to fit
feet flat on the floor, you can use a footrest with adjustable height and your body properly.

tilt to make up for any gap between the floor and your feet. Or you may
lower the desktop to eliminate the need for a footrest. Another option Computef

is to use a desk with a keyboard tray that is lower than the regular work o Arrange the computer so the top of the screen is slightly below your

surface. eye level when you're sitting at the keyboard. The best distance from
= Use alight touch when typing and keep your hands and fingers relaxed. your eyes to the screen is up to you, although most people seem to
Avoid rolling your thumbs under your palms. prefer 18 to 28 inches (45 to 70 cm).
= Position the computer to minimize glare and reflections on the screen
from overhead lights and windows.
32
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Important Don't lift the computer using the flip-out foot. You could
damage your computer. To move your computer, grab the handle on the
top of the computer with one hand; with your other hand, hold the
bottom of the computer.

45-70 cm (18-28 in.)

Shoulders ‘ Top of the screen

relaxed at or slightly below
Tl eye level (You may

Forearms o need to adjust

the height of your
gnd han.df] monitor by raising
na straight your work
fine surface.)
Lower back
supported

Screen positioned
Forearms to avoid reflected
level or tilted glare
down slightly

N\
Clearance under

Thighs tilted slightly work surface

Feet flat on the floor

Avoiding fatigue

Change your seated position, stand up, or stretch whenever you start
to feel tired. Frequent short breaks are helpful in reducing fatigue.

Use a light touch when typing or using a mouse and keep your hands
and fingers relaxed.

Some computer users may develop discomfort in their hands, wrists,
or arms after periods of intensive work without breaks.

If you begin to develop chronic pain or discomfort in your hands,
wrists, or arms, consult a qualified health specialist immediately.
Allow adequate workspace so that you can use your keyboard and
mouse comfortably. Place papers or other items so you can view them
easily while using your computer. A document stand may make reading
papers more comfortable.

Eye muscles must work harder to focus on nearby objects.
Occasionally focus your eyes on a distant object, and blink often while
you work.

Clean your screen regularly. Keeping the screen clean helps reduce
unwanted reflections.
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Safety, cleaning, and power management

S 3f€ty Warning Electrical equipment may be hazardous if misused.
Operation of this product must always be supervised by an adult.
Make sure that you Do not allow children access to the interior of this product and do
= keep these instructions handy for reference by you and others who not permit them to handle any cables.
may use your computer
= follow all instructions and warnings regarding your system For your own safety and that of your equipment, always disconnect the

power plug (by pulling the plug, not the cord) if any of the following

When setting up and using your computer, remember the following: . :
conditions exists:

= Place your computer in a location with adequate ventilation. Never
block the vents on the computer. = you want to remove any parts (leave the cord disconnected as long as

= Your computer has a three-wire grounding plug that will only fit a the computer is open)

grounded AC outlet. If you are unable to insert the plug into the outlet, ™ the power cord or plug becomes frayed or otherwise damaged

contact a licensed electrician to replace the outlet with a properly = you spill something into the case
grounded outlet. = your computer is exposed to rain or any other excess moisture

= Make sure you only connect the modem to an analog phone line, the = your computer has been dropped or the case has been otherwise
type commonly used in residences. Do not connect a digital telephone damaged
line to the modem, because it could damage the modem. = you suspect that your computer needs service or repair

= Never turn on your computer unless all of its internal and external = you want to clean the case (use only the recommended procedure
parts are in place. Operating the computer when it is open or missing discussed in Mac Help)

parts can be dangerous and damage your computer. ,
Be sure that you always do the following:
Important The only way to disconnect power completely is to unplug

the power cord. Make sure at least one end of the power cord is within
easy reach so that you can unplug the computer when you need to.

= Keep your computer away from sources of liquids, such as drinks,
washbasins, bathtubs, shower stalls, and so on.

= Protect your computer from dampness or wet weather, such as rain,
snow, and so on.
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Cleaning your computer equipment

To clean your computer equipment, use only the recommended
procedures discussed in Mac Help.

Warning Do not clean the screen with a cleaner that contains
alcohol or acetone. Never spray cleaner directly onto the screen.
Liquid could drip inside the screen and cause an electrical shock.

Power supply

The power supply in your computer is a high-voltage component and not
user-serviceable. If you suspect the power supply needs service, contact
your Apple-authorized dealer or service provider.

Warning Do not attempt to access the high-voltage area or
power supply. If you suspect the power supply needs service,
contact your Apple-authorized dealer or service provider.

Power-saving and environmental features

Your computer is equipped with energy-saving features that allow it to
conserve energy when not in use. For instructions on adjusting the system
and display sleep settings and additional energy-conservation information,
see Mac Help.

ENERGY STAR®

As an ENERGY STAR® partner, Apple has determined that this product
meets the ENERGY STAR® guidelines for energy efficiency. The ENERGY
STAR® program is a partnership with office product equipment
manufacturers to promote energy efficiency. Reducing energy
consumption of office products saves money and reduces pollution by
eliminating wasted energy.
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Where’s the fine print?

Communications, telephone, and modem
regulation information

For information on FCC regulations, radio and television interference, and
telephone and modem information related to this product, see the files in the
Communications Regulations folder, inside the Documents folder on your hard disk.

Laser information

Warning Making adjustments or performing procedures other than those specified in
your equipment’s manual may result in hazardous radiation exposure.

Do not attempt to disassemble the cabinet containing the laser. The laser beam
used in this product is harmful to the eyes. The use of optical instruments, such as
magnifying lenses, with this product increases the potential hazard to your eyes.
For your safety, have this equipment serviced only by an Apple-authorized

service provider.

CAUTION - INVISIBLE LASER RADIATION WHEN OPEN. AVOID EXPOSURE TO BEAW.

ATTENTION - RAYONNEMENT LASER INVISIBLE EN CAS D'OUVERTURE. EXPOSITION DANGEREUSE AU FAISCEAU.

VORSICHT - UNSICHTBARE LASERSTRAHLUNG, WENN ABDECKUNG GEGFFNET. NICHT DEM STRAHL AUSSETZEN.

ATTENZIONE - RADIAZIONE LASER INVISIBILE IN CASO DI APERTURA. EVITARE LESPOSIZIONE AL FASCIO.

PRECAUCION - RADIACION LASER INVISIBLE CUANDO SE ABRE. EVITAR EXPONERSE AL RAYO.

VARO! - AVATTAESSA OLET ALTTINA NAKYMATTOMALLE LASERSATEILYLLE. ALR KATSO SATEESEEN.

VARNING! - OSYNLIG LASERSTRALNING NAR DENNA DEL AR GPPNAD. BETRAKTA EJ STRALEN.

ADVARSEL!- USYNLIG LASER STRALING, NAR DENNE ER ABEN. UNDGA BESTRALING.

/ADVARSEL - USYNLIG LASERSTRALING NAR DEKSEL APNES. UNNGA EKSPONERING FOR STRALEN.
moss  EH -z £ HESBENBIESELT SRS,

g DANGER - Invisible faser radiation when open. AVOID DIRECT EXPOSURE TO BEAW.

Service warning label
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High-risk activities warning

This computer system is not intended for use in the operation of nuclear facilities, aircraft
navigation or communications systems, or air traffic control machines, or for any other
uses where the failure of the computer system could lead to death, personal injury, or
severe environmental damage.

Camera information

The DV camera pictured on page 12 of this manual is not included with this product. The
model shown may not be available in all areas.

Mouse information

This product complies with the requirements of European Directives 72/23/EEC and
89/336/EEC. Complies with the Canadian ICES-003 Class B specification. This mouse is a
Class 1 LED product. (IEC 60825-1:1993 +A1:1997+A2:2001)

Caution Use of controls or adjustment or performance of procedures other than those
specified herein may result in hazardous radiation exposure.

Every effort has been made to ensure that the information in this manual is accurate.
Apple is not responsible for printing or clerical errors.
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